
     iPod Fever 
101 
 
 
Objective 
 
This class will ‘wow’ you with the iPod’s potential.  Some 
Features of the iPod will be demonstrated such as: 
downloading, making a play list, safety tips, the use of 
photos, and main menu settings. Learn how easy it is to put 
your music collection and more in your pocket. 
 
 
 
Class Overview 
 
Setting iTunes Preferences Address Book

Download Music iPod on the Road

Working with the iPod Radio stations

Working with the Music library Things to consider

Playlists  

 
 
 
 
 
 



 
Setting iTune Preferences 
 
Open up iTunes on your computer. Once iTunes is up, the Preferences 
can be set to the way you would like to work with the program. 
 

 
 

 
To open iTune Preferences on a Mac, choose Preferences from the 
iTunes menu. 
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The iTune Preferences can be reached from the Edit menu on a PC. 
 

 
 
 
The Preference Menu will come up. 
 
                Mac 

 
  
It is very wise to have iTunes check for updates automatically. 
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                  PC 

 
  
Once the Preferences are set, it is time to play the music. 

 
 

Download Music 
 
Music can be stored, organized and shared on your computer through 
iTunes. Music can be downloaded to your computer from your own 
CD’s. Free music can be found on the Internet through several 
sources. Music can be purchased through the Music Store. Music that 
is downloaded to your computer is stored and organized in the Library 
of iTunes.  
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Your library can go from looking like this… 
 

 
 
…to a full library 
 

 

©Ann Arbor District Library 4

        Library 

 

Music Store 



Once you have downloaded songs for your library, notice the bottom 
bar of the library screen. It let’s you know how many items are in the 
library, how many hours of songs, and the amount of space the songs 
take up on your computer. 
 

 
 
 
Once the Library has music, it is time to connect your iPod to the 
computer. The iPod can be connected either by a FireWire cable or by 
using a dock. 
 

 
 

Open the iTunes application. As soon as the iPod application is open, 
the transfer of data begins automatically. By the way, obey the Do 
Not Disconnect warning on your iPod screen. Data could become 
corrupted or the unit could be damaged if disconnection occurs during 
data transfer. 
 
 
Once the data is transferred, the iPod can be ejected from the 
computer. There are several ways the iPod can be disconnected. 
 
Mac 
 

 Click on iPod in the Source list. 
 Click the ‘eject iPod’ button from the bottom right corner of the 
screen. 
 Release the iPod from the FireWire cable or the cradle. 
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PC 
 

 Click iPod in the Source List. 
 Click controls in the top Menu Bar and click on eject. 
 Release the iPod from the FireWire cable or the cradle. 

 
Remember to update your iPod and iTunes software on a regular basis. 
 
 
 
Working With the iPod 
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The Apple Click Wheel is a unique menu that displays options for 
audio, customizing and maintenance. The Select button is the round 
button in the middle. 
 
 

 
Right pointing arrow 

 
Menu Button – when pressed it displays options related to playing the  
                      audio, to customize settings, and for maintenance. 
 
 
Selection Button – is the round button in the middle. 
 
Double left pointing arrows – press once to return to the beginning of  
                                          a song or hold it to rewind through the  
                                          song.  If pressed multiple times it will get   
                                          back to your playlist. 
 
Double right pointing arrows – are the Next and Fast Forward. Press  
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Menu Button 

   
Double left pointing arrows 

 

Double right pointing arrows 

Selection Button 



                                             once to go to the next song. Hold down 
                                             to Fast Forward through a song. Press 
                                             multiple times to go forward though the 
                                             songs on the Playlist. 
 
Right pointing arrows – is the Play/Pause button. Press once to play, 
                                  press again to Pause. 
                                
 
 
 
To navigate your iPod: 
 

1. Scroll to desired category and click and then click the Selection 
button. 

2. Scroll to the next menu and click on the desired choice. 
3. To return to the previous selection press Menu. 
 

To find a particular song: 
 

1. Click on Music using the Select button 
2. Select the desired category and click. 
3. Scroll until you see what you would like to hear and click. The 

name of the album appears at the top of the screen. Click once 
more and the song begins to play. 

 
 
 

 To turn your iPod on, press any button. 
 

 To lock your iPod, move the switch at the top so that the orange 
bar is showing. 

 
 
 
 
Working With the Music Library 
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iTunes makes the move from a CD to your computer a breeze. You can 
select certain songs to import or enjoy a complete CD. What happens 
when iTunes imports the music to your computer is that it converts 
each song to a file. This file is compressed. The compression, however, 
does not change the quality of the music that you have chosen. 



 
The iTunes Music Store is an alternative to importing CD’s. In order to 
store music in the Music Library, the iTunes Setup Assistant should be 
downloaded to your computer. Follow the installer’s on-screen 
instructions and your computer will store your music in one place. The 

installer will place a Music Store icon.  Clicking on the 
icon will bring you to the Music Store where you can download songs 
for just 99¢, albums can be bought at $9.99 or more, music videos and 
TV shows can be bought at $1.00 or more. The purchased items go 
from the Music Store to your Music Library. From that point you can 
pick and choose the music for your iPod. 
 
The Music Library offers a variety of ways to organize Music Store 
purchases. 
 

 
 
The left column (Source) offers folders for organizing music, videos 
and podcasts. The Source includes the Music Store icon and Shared 
Music, along with personal folders such as 90’s Music, My Top Rated 
Music, etc. 
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The toolbar at the top of the screen gives the user several options for 
seeking (using the back and forward button), browsing (selecting a 
certain song), or searching by entering a term in the Spotlight feature. 



 

 
 
As you work with the downloaded iTunes on your computer with your 
iPod plugged in, iTunes is stored in both places. If you add anything to 
your iTunes the next time you plug in your iPod, iTunes will 
automatically update your iPod. 
 
To delete a song from your Music Library in iTunes, just click on the 
song you would like to delete and use the Delete key on your 
keyboard. 
 
 
 
 
Playlists 
 
Playlists are a way of arranging the music to suit you and your life 
style. You may have one playlist with songs while you exercise, 
another one may be a playlist used during your drive time to and from 
work or one organized to keep you up and alert during such times as 
household chores, yard work, or time spent on a hobby. 
 
From the File menu choose new Playlist and the playlist will appear in 

the Source column of iTunes.  Keeping the playlist 
selected, you can type any name you would like. 
 

 Select a song from the library you would like in the playlist. Drag 
the song onto the playlist icon. Dragging the song to the playlist 
icon does not remove the song from the Music library. It just 
makes a copy on your playlist. 
 Several songs can be selected at once by holding down the 
command for shift key (PC) and drag onto the playlist icon. 
 To look at all the songs in your playlist, click on the playlist icon 
in the Source column. 
 To change the order of the songs you selected, click on the song 
number column, and then you can drag the song names to the 
order you would like. 
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 When you have your playlist selected in the Source column, look 
at the bottom of the iTunes window. The window displays the 



number of songs, total playlist duration and the amount of disk 
space that the playlist takes up. 
 To the left of each song title is a checkbox. The checkbox can be 
selected to deselect a song. Deselected songs will not play and 
will not be included in the playlists when the iPod is synched to 
your computer. 

 
Smart Playlists 
 
Smart Playlists uses conditions to determine what goes into the 
playlist. If you want to have a playlist with all of your favorite songs, 
Smart Playlist would be the one to use. 
 
Example: 

 Under the File menu, select New Smart Playlist. 
 Use the “Match the following condition” option. 
 A pop-menu will open if you select the name of the Artist. 
Choose the year. In the next pop-up menu choose “is in the 
range”. Finally type in the time span of your search. 
 Whenever new music is imported select “Live updating”. “Live 
updating” will be looking for your search criteria as the music is 
imported. 
 The icon of the Smart Playlist is different from the Playlist.  

 
 

 
 

 
 
Address Book and Contacts 
 
Another great feature of the iPod is Calendar and Contacts. This is a 
very busy world and any option that helps us keep our life in order is a 
plus. The Address Book and Contacts can be used with either the PC or 
Mac. 
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If you are familiar with the Address Book and iCal on the Mac, you are 
ready to go. If not take the time to try out both these Mac features. 
On the PC side, you must have Outlook or Outlook Express on your 
computer and the industry-standard vCalendar and vCard files. The 



Calendar and Contacts feature on either the Mac or the PC can be 
synched by iTunes to your iPod. You can access these features with a 
quick spin of the Click Wheel. 
 

 Help 
 iPod Help 
 go to iPods manual on the web 
 Click on the manual that fits your iPod. 
 www.apple.com/support/manuals/ipod 
  

 
 
iPod and the Car 
 
Your iPod can be taken on the road and integrated between your car 
and your iPod. The site www.apple.com/ipod/ipodyourcar will give you 
the necessary information to use your iPod with your car. If the car 
model you need is not on the site, it is suggested to go to a car stereo 
dealer for more information. 
 
Just last week on a boating day, the iPod and boat worked beautifully 
together for the whole day! 
 
Radio Stations and iTunes 
 
Just as you listen to your favorite radio stations from your car, you can 
enjoy Internet Radio through iTunes. Broadband Internet access will 
bring the better-sounding streams. 
 

 Connect to the Internet. 
 In the Source column of iTunes, select Radio. Genre will appear 
in the right column. 
 A triangle will appear before the genre. Click on the triangle. 

 

 
 

 The radio stations that are streaming will appear. Under the 
Comment column there is a description of the type of music 
played. 
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http://www.apple.com/support/manuals/ipod
http://www.apple.com/ipod/ipodyourcar


 
 

 Double-click on the station you would like to hear. 
 
You could create a new playlist just for the radio stations you like. Just 
drag the stations from the list onto your playlist. There will be a radio 
icon in front of the stations names on the playlist. 
 
You could also go to the web-page of the radio station. Some stations 
have a “listen online” link. The link may add the radio station to your 
iTunes Music Library and start playing. 
 
Things To Consider 
 
Storage Space 
 
When the iPod is connected to the computer, go to iTunes. The bottom 
of the iTunes window will display the amount of storage. 
 
or 
 

 Turn your iPod on. 
 Scroll to Settings and press Select button. 
 Click on ABOUT and press the Select button. 

 
 
iPod Batteries 
 
Lithium batteries provide the best performance for your iPod. Lithium 
batteries can be recharged whenever convenient. Nickel batteries must 
be fully discharged before recharging. 
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Taking care of your iPod will be taking care of the battery life. Battery 
life means how long the iPod will run before a recharge is necessary. 
The iPod should not be left in an area where heat will build up. Leaving 
the iPod in the sun, a hot car, or even a glove compartment will affect 
the batteries performance. 



Software Updates 
 
Both Mac and PC owners should always download the latest software. 
For the Mac owner, this can be down through Software Updates. The 
Software updates can be found under the  below About This Mac. 
For both Mac and PC owners the latest software downloads can be 
obtained through the Apple support site 
www.apple.come/support/ipod/. 
 
Further information regarding the life of the iPod battery can be found 
at www.apple.com/batteries/ipods.html. 
 
Settings 
 

The Main Menu offers the iPod owner a wealth of choices to enjoying 
using the iPod. 
 

 Date and Time 
 Language 
 Backlight Timer 
 iPod Sounds 
 Set maximum volume sounds. 
 Clicker sound effects. 

 
Extras 
 
The Extras menu has some fun and additional items of use. 
 

 Calendars 
 Contacts 
 World Clock 
 Screen Lock 
 To-Do-Lists 
 Built-in Stop watch 
 Games 

 
Yes, the iPod fever is out there. In your pocket, in the car, and in your 
lifestyle, today it is the iPod. 
 
The information and some images came from a wonderful site on the 
Internet from Apple. Go to www.apple.com/ipdo/ipod.html for further 
investigation and customization. 
 
7/11/2006 
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